
The Process (3D Model Guide) 1

The Process (3D Model Guide) 
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Tags

Phase 1
A- Checking size scale to UE standard:
Ensure your model’s scale matches Unreal Engine’s standard units. Typically, 1 unit in Maya equals 1 centimeter. Adjust the 
scale settings in Maya to match this standard.

Resources

For MAYA.

https://youtu.be/q0ev5MbI3gk

For Blender.

@September 22, 2024 1:39 PM

https://youtu.be/q0ev5MbI3gk
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B- Base model:
Use the modeling tools to shape your model as needed.

Resources

For Maya.

https://youtu.be/eBEitxaRYQs

For Blender.

https://youtu.be/sc24Yu9eCS8

For UE.

https://youtu.be/NZYxf2IbL5E

https://youtu.be/eBEitxaRYQs
https://youtu.be/sc24Yu9eCS8
https://youtu.be/NZYxf2IbL5E
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https://youtu.be/DaEJZHnz0V0

C- Appropriate naming structure:

Examples can be found on the WIP Proton Drives LINK HERE

Resources

1. Due to the specifics of Unreal Engine, we require all assets, such as Static Mesh and others, to use naming 
conventions for Unreal Engine.

We also use some of our own naming conventions. For a complete example, visit the Plunger Blender project and have 
a look around.

2. Materials follow a simple M_Nameofmaterial format. If there are multiple variations of a model with different 
materials, adding a suffix is sufficient. For example, Salmon and Borka have _salm and _bork. The same goes for 
static meshes, empties, etc.

https://youtu.be/DaEJZHnz0V0
https://drive.proton.me/urls/S78CHEWM70#K1F6PVxxgITw
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3. For moving parts, we usually divide them into the base model that connects them to the non-movable part (_base), 
the horizontal rotating part (_hortrot), and the vertical rotating part (_vertrot). Guns, turrets, spotlights, engines, and 
wheels usually have two or all three of these.

If it's only one piece of the part and it rotates, or if there are two parts rotating in the same direction, then just 
adding _Rot is enough.

Sometimes we just name them with directional suffixes, as it is enough to identify them.
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4. Armatures are named Armature_nameofmodel. Rig bones usually have a root, and in the case of vehicles, parts are 
named nameofbone_direction, starting from the root:

FR (front right) 
FL (front left)
BR (back right)
BL (back left)
T (top) after direction, e.g., nameofpart_F_T
B (bottom) after direction, e.g., nameofpart_F_B
F (front) 
B (rear) before vertical, nameofpart_B_B would be rear bottom 
R (right)
L (left)

Plunger Example (WIP)
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So, as an example in the GuardTower of Plunger, the front machine gun has a grab for the hand on the left side. That 
would be nameofbone_F_L or _R.
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The GuardTower also has a bone for animators to easily connect the hands of characters. There are two on that piece, 
serving as stepping points for climbing or releasing a VFX, one on the left and one on the right, so _L and _R.

If there is a point for VFX like engine smoke, we add a bone with the suffix bonename_VFX. If it is an impact point for 
coders, located on the front top part of the car, then it is ImpactPoint_T_F, etc.

5. Here is an awesome example of proper naming for a rig and mesh.
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Helps identify and divide all parts accordingly, such as one cabin having three management zones.

The top one also makes it easy to avoid a spaghetti-like hierarchy.

It is easy to manipulate or divide sections when needed. It is a goldmine for animators and coders.
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All of this has its reasons and eases the workflow for other disciplines.

D- Material slots:
Assign materials to different parts of your model and assign them to your model’s faces or objects.

Resources

For Maya.

https://youtu.be/aJhXITez20Y

For Blender.

https://youtu.be/K3wMqyjvgtE

For Unreal.

https://youtu.be/2d30APnrJBk

E- Centering and setting transformation:
Center the pivot point of your model to geometry. Check in Blender for examples.

https://youtu.be/aJhXITez20Y
https://youtu.be/K3wMqyjvgtE
https://youtu.be/2d30APnrJBk
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Resources

For Maya.

https://www.youtube.com/watch?v=OmBxBNJwB8w

For Blender.

https://youtu.be/LHIvN5ZqdTU

For Unreal.

https://youtu.be/zdjG2pjGpsE

F- Setting up parenting, creating a hierarchy:
Parent objects to create a hierarchy. Select the child object, then the parent object, and press P to parent them. This 
creates a hierarchical relationship between objects.

Resources

For MAYA.

https://youtu.be/1ahz51RWT2A

For Blender.

https://youtu.be/VnXW_r9tTvo

For Unreal.

https://youtu.be/k92eaGP4pss

Phase 2

https://www.youtube.com/watch?v=OmBxBNJwB8w
https://youtu.be/LHIvN5ZqdTU
https://youtu.be/zdjG2pjGpsE
https://youtu.be/1ahz51RWT2A
https://youtu.be/VnXW_r9tTvo
https://youtu.be/k92eaGP4pss
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A- Creation of an armature and setting up bones:
Create a skeleton for your model by placing joints at key points to form the skeleton.

Resources

Export/Import Tips.

For MAYA.

https://youtu.be/J18m_RD8plI

For Blender.

https://youtu.be/jbFjTFFwPsM

For Unreal.

https://youtu.be/txFsPf-BlEg

B- Creating bone collections based on areas or joint function:
Group bones logically based on their function or location (e.g., arm bones, leg bones). This helps in managing the rig more 
efficiently.

Resources

MAYA/Blender difference.

https://youtu.be/J18m_RD8plI
https://youtu.be/jbFjTFFwPsM
https://youtu.be/txFsPf-BlEg
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MAYA Rigging

https://youtu.be/1wvdQy2Fdhw

Blender Rigging

https://youtu.be/DDeB4tDVCGY

Blender Rigging for Unreal with Free Unreal Plugin.

https://youtu.be/0lwKWxBeFcQ

UE5.4 New Control Rig

https://youtu.be/0KrrE4heS7s

C- Parenting meshes to bones, positioning bones for later connections:
Attach meshes to bones by selecting the mesh, then the joint, and parenting it to it. Position the bones correctly to ensure 
proper deformation.

Resources

Differences in Blender and MAYA, Unreal.

https://youtu.be/1wvdQy2Fdhw
https://youtu.be/DDeB4tDVCGY
https://youtu.be/0lwKWxBeFcQ
https://youtu.be/0KrrE4heS7s
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For MAYA.

https://youtu.be/FSvEb91T7aM

For Blender.

https://youtu.be/FSvEb91T7aM
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https://youtu.be/yIpVj94_GNA

For Unreal.

https://youtu.be/8N3r92InMxI

D- Assigning and creating vertex groups of the meshes:
Define vertex groups for deformation. This assigns vertices to groups.

Resources

For Blender.

https://youtu.be/yIpVj94_GNA
https://youtu.be/8N3r92InMxI
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https://youtu.be/OYg2fyQMtJc

For Maya.

https://youtu.be/OYg2fyQMtJc
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For Unreal.
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E- Creating modifiers to “bake in” said vertex groups to the armature:
In Blender, this involves creating a deform armature modifier, selecting the armature, selecting the previously defined vertex 
group, and applying it. That "bakes it in.

Resources

For MAYA.

https://youtu.be/WQMjCm-KAis

For Blender.

Add a modifier to meshes with created and set vertex groups.

https://youtu.be/WQMjCm-KAis
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Choose Armature Deform Modifier.

Choose parented armature and created vertex group.
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Apply. Repeat on all meshes.

You can also select all the meshes (be careful to choose only meshes, which is why proper naming is important to help 
in these parts) and, as the last one, choose the one set to armature but with no vertex group selected. It would look like 
this.
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Select the last object with CTRL+Click, move the mouse to the main area, and press Ctrl+L. Select 'Copy Modifiers'.

If properly applied, it will look like this.
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A bit tedious, go one by one and add the vertex group for each. Apply.

The end result should look like this.
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In Unreal.

https://youtu.be/mtven29plfc

https://youtu.be/mtven29plfc
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F- Connecting the bones of the armature:
Connect bones and control their behavior.

Resources

For MAYA.

https://youtu.be/depyrdgYSgo

For Blender.

Connecting Bones.

https://youtu.be/DKCPY1wsW90

More Explanation.

https://youtu.be/gdOaUv0_TC8

For Unreal.

https://youtu.be/MMe80uQr_Vg

G- UE export/import tests, fixing any issues:
Export your model to Unreal Engine using the FBX format (File > Export Selection). Import it into Unreal Engine and test for 
any issues. Fix any problems in Maya and re-export as needed.

Resources

For MAYA.

https://youtu.be/YEyo1WkgDgE

Fir Blender.

Unreal Free Export Plugin.

https://youtu.be/depyrdgYSgo
https://youtu.be/DKCPY1wsW90
https://youtu.be/gdOaUv0_TC8
https://youtu.be/MMe80uQr_Vg
https://youtu.be/YEyo1WkgDgE
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GitHub - xavier150/Blender-For-UnrealEngine-Addons: I have created this addons for export asset from Blender to Unreal Engine 4
I have created this addons for export asset from Blender to Unreal Engine 4 - xavier150/Blender-For-UnrealEngine-Addons

https://github.com/xavier150/Blender-For-UnrealEngine-Addons

Blender Export Settings.

Make sure all selected and visible (the eyes on the right).

Select Export .FBX.

https://github.com/xavier150/Blender-For-UnrealEngine-Addons
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Settings
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Name it appropriately.

Phase 3
A- Texturing:
Apply textures to your model using the Substance app. Create and assign materials, then use UV mapping to ensure 
textures fit correctly on your model.

Resources

MAYA Substance

https://youtu.be/Tjl9bPoP9LM

Substance in Blender

https://youtu.be/Tjl9bPoP9LM
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https://youtu.be/jCwTEEyDX3Y

Unreal Technical Details.

https://youtu.be/WqFTYh_KZkQ

B- Texture variations:
Create different texture sets for your model. Duplicate your material and adjust the textures to create variations (e.g., 
different colors, patterns).

Resources

General Idea:

The only prerequisite is that the previous steps are done correctly. As I don't have experience in MAYA, I will use 
Blender next as an example of what needs to be done so it can be understood in MAYA too.

Blender has switchable folders. Notice the right-side selection. You create them and put stuff in them, then you get the 
option to turn them off and on.

Now switched. The same model variation is saved in the same Blender project as a separate model with its own folder.

https://youtu.be/jCwTEEyDX3Y
https://youtu.be/WqFTYh_KZkQ
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Then we need to set the name variations and name identification markings. Example Borka 

Salmon
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Names are inherited in Unreal, including mesh and material slots. They need to be correctly distinguished and named 
for each variation. We have a rename addon for this, and there's no way to avoid it. If previous phases are done 
incorrectly, the next step will not complete successfully.
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If done correctly, you can see there are more than a hundred material slots. Does it look like it uses that many? No.

I can easily type all slots with the same name that are supposed to look alike in the right panel, select the material in the 
left panel, and just click a few times on all the apply material buttons in a matter of seconds. That means, like in real life, 
I can paint whole sections quickly or each one differently down to the minor realistic detail if desired.

So it is very important to get all of it right for technical reasons and premium features that increase price or attract 
enthusiasts.
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C- Baking in the texture:
Bake textures to create texture maps that can be used in Unreal Engine. Use Lighting/Shading > Transfer Maps to bake 
textures like ambient occlusion, normal maps, etc.

Resources

MAYA Baking

https://youtu.be/I9IVtq3wrbs

Substance 3d Baking

https://youtu.be/hYtHp4IXvsM

For Blender.

https://youtu.be/SDqpnfTRtIU

Addons.

For baking, we use the Bakemaster addon. However, if you have an equivalent in MAYA that you are comfortable with, 
please use that one. It just needs to be importable correctly.

https://bakemaster-blender-addon.readthedocs.io/en/latest/pages/about.html

For Unreal.

https://youtu.be/VNU_IGSkJ8s

Phase 4
Promotion renders:
A- Render images of your model for promotion. Set up lighting and cameras in Maya, then use Render > Render Sequence 
to create high-quality images.

Resources

https://youtu.be/I9IVtq3wrbs
https://youtu.be/hYtHp4IXvsM
https://youtu.be/SDqpnfTRtIU
https://bakemaster-blender-addon.readthedocs.io/en/latest/pages/about.html
https://youtu.be/VNU_IGSkJ8s


The Process (3D Model Guide) 33

For MAYA.

https://youtu.be/xPgAolYL_qQ

For Blender.

https://youtu.be/VoHZ8lemEtk

For Unreal.

https://youtu.be/wjUhUhSQJBI

B- Packing & uploading for QA:
Prepare your model for quality assurance by organizing all files (e.g., textures, models, rig files). Compress them into a 
single package and upload it to your QA team or platform.

Resources

In MAYA.

https://youtu.be/xPgAolYL_qQ
https://youtu.be/VoHZ8lemEtk
https://youtu.be/wjUhUhSQJBI
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In Blender.
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In Unreal.
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Topology expectations
BLENDER

Do not forget to set your viewport to these settings to see face orientations. In UE, the import it not based on normals but 
on the face orientation.
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IMPORTANT #1

EXAMPLE: A model that has seemingly no issues.
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It will result in Backface Culling to show you the missing faces.

As of production, these models were not meant to be 'walk-in-able.' Therefore, they need some additional attention to fix 
this issue. All models should have double sides where you would expect them if you were to walk into them in real life.

Resources

https://cdn.discordapp.com/attachments/1301169666319847434/1301178796749230252/Blender_2024.10.30-08.
37.mp4?ex=672f662f&is=672e14af&hm=bb74d97235c62e041711a7a461033229e414e52cf29d26fe62e4d05ff65
df3ba&

IMPORTANT #2

If you work with glass material, make it a separate mesh from the rest of the object. UE does not support Nanite for 
transparent materials, so windows, glass, or anything transparent must be in its own mesh. Failure to do so means we can't 
use Nanite on the object, which results in performance loss.

A simple fix for a serious issue: just make windows and other transparent elements separate.

Comrade Lenin will help us with this task. As you can see, the issue is that Nanite with glass materials or anything 
transparent will not load. In a setting with hundreds or thousands of pieces, this can have a significant impact. The simple 
solution is to separate the transparent elements from the rest.

Resources

https://cdn.discordapp.com/attachments/1301169666319847434/1301178796749230252/Blender_2024.10.30-08.37.mp4?ex=672f662f&is=672e14af&hm=bb74d97235c62e041711a7a461033229e414e52cf29d26fe62e4d05ff65df3ba&
https://cdn.discordapp.com/attachments/1301169666319847434/1301178796749230252/Blender_2024.10.30-08.37.mp4?ex=672f662f&is=672e14af&hm=bb74d97235c62e041711a7a461033229e414e52cf29d26fe62e4d05ff65df3ba&
https://cdn.discordapp.com/attachments/1301169666319847434/1301178796749230252/Blender_2024.10.30-08.37.mp4?ex=672f662f&is=672e14af&hm=bb74d97235c62e041711a7a461033229e414e52cf29d26fe62e4d05ff65df3ba&
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https://cdn.discordapp.com/attachments/1301169666319847434/1301181990866911242/unknown_2024.10.30-0
8.50.mp4?ex=672f6929&is=672e17a9&hm=df640e291bb9f404d93dbc2604fe9de34c1efffa23d18fb79360b74a5c
9150b3&

IMPORTANT #3

Unwrapping can be tedious, but we have a solution in the form of three addons: Unwarp Me - Auto UV, Symmetry++ to fix 
cross-face or edge topology issues, and Quad Star Fill for those super tedious circles.

1. https://blendermarket.com/products/unwrap-me

2. https://blendermarket.com/products/symmetry-

3. https://blendermarket.com/products/quad-star-fill

Study the descriptions and understand what they do, as this will save you countless hours.

What does it look like to work with this set of unwrapping tools? (applies when you don't need to work on the textures 
manually or by hand, for lets say prototypes or WIP’s)

EXAMPLE

https://cdn.discordapp.com/attachments/1301169666319847434/1301188969580728521/Blender_2024.10.30-09.17.m
p4?ex=672f6fa9&is=672e1e29&hm=523c1a68c5ea1741145a51f97fd9bea1c68f57f163df4fc031124861ecf2c1f9&

As you can see, it is a matter of a few clicks, and it works much better than the Unwrap function. It is also more compatible 
with UE. You should apply the textures after this point because, with the textures set, you cannot change the UVs anymore. 
So, it is very important to do this. This function also detects if Blender generated disconnected vertices or overlapping 
edges, as it marks the boundaries.

It can mark issues that are not visible in the standard viewport.

As this particular part of the model was kind of broken during its creation due to my lack of knowledge back in the day.

https://cdn.discordapp.com/attachments/1301169666319847434/1301181990866911242/unknown_2024.10.30-08.50.mp4?ex=672f6929&is=672e17a9&hm=df640e291bb9f404d93dbc2604fe9de34c1efffa23d18fb79360b74a5c9150b3&
https://cdn.discordapp.com/attachments/1301169666319847434/1301181990866911242/unknown_2024.10.30-08.50.mp4?ex=672f6929&is=672e17a9&hm=df640e291bb9f404d93dbc2604fe9de34c1efffa23d18fb79360b74a5c9150b3&
https://cdn.discordapp.com/attachments/1301169666319847434/1301181990866911242/unknown_2024.10.30-08.50.mp4?ex=672f6929&is=672e17a9&hm=df640e291bb9f404d93dbc2604fe9de34c1efffa23d18fb79360b74a5c9150b3&
https://blendermarket.com/products/unwrap-me
https://blendermarket.com/products/symmetry-
https://blendermarket.com/products/quad-star-fill
https://cdn.discordapp.com/attachments/1301169666319847434/1301188969580728521/Blender_2024.10.30-09.17.mp4?ex=672f6fa9&is=672e1e29&hm=523c1a68c5ea1741145a51f97fd9bea1c68f57f163df4fc031124861ecf2c1f9&
https://cdn.discordapp.com/attachments/1301169666319847434/1301188969580728521/Blender_2024.10.30-09.17.mp4?ex=672f6fa9&is=672e1e29&hm=523c1a68c5ea1741145a51f97fd9bea1c68f57f163df4fc031124861ecf2c1f9&
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IMPORTANT #4

Use a UE5 mannequin to measure the scale of your buildings; we now use it as the standard. Also, set Blender's scale to 
centimeters. <Super important

IMPORTANT #5

Blender sometimes creates unwanted vertices or "garbage". There is a quick fix you should apply before unwrapping, 
atlasing, or substance painting.

In Edit mode (when you edit the mesh):

In the Mesh tab, you'll find a wonderful set of tools called CleanUp. Let me show you how great it is on a seemingly ready 
mesh.
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A great example is this soldered link fence.

https://cdn.discordapp.com/attachments/1301169666319847434/1301935134496264202/Blender_2024.11.01-10.43.
mp4?ex=672f8394&is=672e3214&hm=5443a92f70f582f973f83ea97fab8fe67ce94b535bce730f717213968f89b9b6
&

Notice the vertex count removed in the bottom pop-up, and it did not ruin the mesh at all. This is garbage being removed 
that was either created by user error or most likely by Blender misinterpreting how many times you clicked or due to engine 
lag.

Also, if your mouse or keyboard has a low battery or just does unreliable things.

It's an easy fix for making the model game-ready. 

BE WARNED!

Merging vertices may dissolve two faces in some cases, creating holes in the mesh. Apply this fix 
before you address topology face issues. Use the correct viewport settings as mentioned in the 
above points to avoid this. There is nothing worse than discovering it after you have painted 
everything.

COMING SOON!

https://cdn.discordapp.com/attachments/1301169666319847434/1301935134496264202/Blender_2024.11.01-10.43.mp4?ex=672f8394&is=672e3214&hm=5443a92f70f582f973f83ea97fab8fe67ce94b535bce730f717213968f89b9b6&
https://cdn.discordapp.com/attachments/1301169666319847434/1301935134496264202/Blender_2024.11.01-10.43.mp4?ex=672f8394&is=672e3214&hm=5443a92f70f582f973f83ea97fab8fe67ce94b535bce730f717213968f89b9b6&
https://cdn.discordapp.com/attachments/1301169666319847434/1301935134496264202/Blender_2024.11.01-10.43.mp4?ex=672f8394&is=672e3214&hm=5443a92f70f582f973f83ea97fab8fe67ce94b535bce730f717213968f89b9b6&
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Phase 5 (For resident UE expert)
A. Unreal Blueprint Coding: 
Implement all features to ensure the project is playable out of the box, adhering to requirements and specifications. Coding 
is performed in C++ and made accessible through Blueprint events. The project must be packageable and suitable for 
regular testing or sharing updates.

Resources

B. Unreal Animation: 
Create or import animation blueprints, sequences, and blends using a premade project.

Resources

C. Game Readying & Optimization: 
Utilize Nanite with meshless skeletons, virtual shadow maps, and Lumen for optimal performance. Ensure good Lightmass 
performance, resolution, and project cleanliness. Measure performance through metrics.

Resources


